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Welcome to QuickBooks 

Congratulations. You are about to experience your business in 
a whole new way. Clear, organized, managed. Whether you’re  a 
seasoned entrepreneur or starting up your very first business, 
QuickBooks is your solution for efficient financial management. 
Save time. Save money. Do business better.  

Intuit’s online Getting Started Center – quickbooks.ca/
getstarted – and this Getting Started Guide will walk you 
through some set-up essentials. 

•	 Install QuickBooks & Set up your company file.
•	 Perform common QuickBooks activities.   
•	 Navigate your QuickBooks with ease. 
•	 Support options when you have questions.
•	 Set up your Payroll in QuickBooks. 

Upgrading from a previous version?

Welcome back! You’ll find all the upgrading information you 
need in the “Upgrade QuickBooks” section of this guide.
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Support Options

3 easy ways to get help if you need it

Call us. You benefit from a free session 
with a QuickBooks expert within 
60 Days of registering your software.  
1-877-772-9158 (Monday to Friday,  
8 a.m. to 8 p.m. EST).

Visit Intuit’s Getting Started Centre. 
Your source for FAQs, how-to-videos, and 
tips and tricks to get you up and running.  
Visit quickbooks.ca/getstarted 

Click the Help Menu to access in-
product support. Access the Learning 
Centre’s interactive tutorials, join the 
QuickBooks Live Community, and more.

Familiar with QuickBooks,  
but have a question?
Visit our Support site for extensive self-help guidance, including 
FAQs, user guides, or chat with a with a virtual agent 24/7.  
Go to quickbook.ca/support



QuickBooks Getting Started Guide  | 3

Install QuickBooks in 3 easy steps

To install QuickBooks:
1.	 Shut down all running programs, including antivirus 

programs. (Remember to turn them back on once 
installation is complete).

2.	 Insert the QuickBooks CD into your CD-ROM drive.

If installation does not start automatically, 

•	 Click Start from your Windows menu  
(bottom left of your screen)

•	 Choose Run
•	 Type D:\setup.exe  

(Where “D” is your CD drive)
•	 Click OK

3.	 Follow the on-screen instructions

	

Where should I install QuickBooks?

We recommend that you accept the default folder 
location. Windows Vista and Windows 7 require program 
files to be installed in different locations than in previous 
operating systems. The new location is compatible with 
these new requirements.
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To start QuickBooks, double-click the QuickBooks 
icon on your desktop, or click the Windows Start 
button and then click QuickBooks from the 
Programs group.

Register your copy of QuickBooks

Under the Help Menu, select Register QuickBooks. Registration 
must be made within 30 days of product installation. It only 
takes a few minutes to activate your product and get you on 
board.  By registering, you’ll be able to use your free support call 
and will have access to other support resources. 

Where can I find my License and  
Product Numbers? 

If you purchased QuickBooks:
•	 From a retail store, your numbers are on the Getting 

Started folder.
•	 By calling Intuit directly:

•	 Your numbers are on the packing slip, 
•	 In an email (if you gave one to the sales 

representative), 
•	 Or you may have received it over the phone.

•	 From our website, your numbers are on the Web receipt.

Setting up a multi-user environment

For instructions on how to set up a multi-user environment, 
or to add new users, visit quickbooks.ca/getstarted
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Let’s get started

Making the transition to QuickBooks is much easier when 
you have the knowledge you need to enter your information 
correctly. That’s why we’ve provided valuable resources in 
this section that will help you get up and running quickly and 
accurately, then get right back to business. 

Set up your company in QuickBooks
The first thing you need to do in QuickBooks is set up a company 
file for your business. Setting up your company file properly is 
the most important thing you can do to manage your business 
efficiently and with confidence. 

As you set up your company file, QuickBooks prompts you for 
details about your business. Before you begin the setup process, 
gather the information in the Getting Started Checklist on the 
following two pages.
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Getting Started Checklist

Company name 
and address

You will need both the legal name 
and the “doing business as” (dba) 
name for your company. The legal 
company name is the name you 
use when filing taxes for your 
business. The “doing business 
as”  name appears on invoices, 
statements, reports, etc. 

Business 
Number (BIN)

This is the 9-digit business 
number issued to you by the 
Canada Revenue Agency (CRA). 
Not all businesses need a BIN. 
You need one if you collect sales 
tax, have employees, or your 
business is incorporated. For more 
information on Business Numbers, 
visit the CRA website at  
http://www.cra-arc.gc.ca 

Sales Tax 
Information

The sales taxes you pay and 
collect (GST, HST, PST, and/or QST), 
what you charge it on, and how 
much of each sales tax you owe as 
of your start date.
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Start Date QuickBooks requires a start date 
as the point at which you begin 
entering your business transactions. 
You must enter all historical 
transactions between your start 
date and today’s date to ensure 
complete accounting records for 
your business.

Many businesses use the first day of 
their fiscal year, so that they can see 
transactions for the entire year. If 
this is not important to you, you can 
choose a different start date, such 
as today or the first of the month, 
quarter, or year.

Bank 
Statements, 
Credit Card 
Accounts, and 
Outstanding 
Cheques

You need your latest bank 
statement balances and 
information about any outstanding 
cheques, deposits, withdrawals, 
or  charges applicable to all the 
accounts you want to set up and 
manage in QuickBooks.  This 
includes credit cards, bank accounts, 
lines of credit, and loans.

Optional 
Information

Eventually, you will need to enter 
detailed information about your 
customers, vendors, and employees, 
as well as the products and services 
you sell, the products that you hold 
in inventory, and any additional 
assets. 
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After you have gathered the information listed in the Getting 
Started Checklist, you can set up your business in QuickBooks 
using the EasyStep Interview. The EasyStep Interview walks 
you through the setup process and helps you tailor QuickBooks 
for your business. The setup interview is divided into sections, so 
you can save your progress and return at a later time.

Start the EasyStep Interview
1.	 Start QuickBooks by double-clicking the QuickBooks icon   

on the desktop, or by choosing QuickBooks from the 
Programs group on the Windows Start menu.

2.	 Click Create a New Company, or from the File menu 
choose New Company.

3.	 Follow the on-screen instructions to complete the interview. 

Enter historical transactions
If your start date is before today’s date, you will need to enter 
past transactions that occurred between that date and today. 
This ensures that your QuickBooks records are completely up-to-
date and reports are accurate.

Enter historical transactions in chronological order. For example, 
QuickBooks won’t know how to credit a customer payment 
unless you’ve already entered the invoice applicable to that 
customer.
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Note: Entering historical transactions is especially 
important if customers don’t pay you at the time 
they receive goods or services. If you don’t enter 
historical transactions early on, it’s hard to track 
and collect late customer payments.

Intuit recommends that you enter your 
transactions in this order:
1.	 Invoices or statements you sent out since your start date
2.	 Purchase orders you issued since your start date that you 

haven’t received in full
3.	 Cash or cheques you received since your start date
4.	 Bills you received since your start date
5.	 Bills you paid since your start date
6.	 Deposits made to any of your accounts since your start 

date
7.	 Any other cheques you wrote (for things other than bills) 

since your start date
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Complete your bank account information
After you enter historical transactions, your account registers will 
reflect bills paid, cheques written, and deposits received. 

To ensure your account registers are complete, you must also 
enter these transactions:

•	 Cheques or other charges that happened before your start 
date but didn’t appear on statements before your start date 
(i.e., cheques or other charges that didn’t clear)

•	 Other cheques you wrote after your start date that were not 
for bills or accounts payable (such as credit card payments)

•	 Deposits you made after your start date that were not from 
customers

•	 Deposits you made before your start date, but that didn’t 
appear on statements before your start date

•	 Bank charges and fees
•	 Interest paid on your account
Refer to the Help Menu in QuickBooks for step-by-step 
instructions on how to enter these transactions to make your 
account registers accurate.
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Common Tasks
Adding an Account
When you set up your company file, QuickBooks automatically 
creates several accounts for you. As your business grows and 
changes, you might need to add new accounts to your Chart of 
Accounts to better organize your finances.

Tip: For a video introduction to accounts (and 
other topics), visit quickbooks.ca/videos

To add an account:
1.	 Go to the Lists menu and click Chart of Accounts.
2.	 Click the Account menu button, then click New.
3.	 Select the type of account you want to create, then click 

Continue.
4.	 Enter information about the account:

•	 In Account Name, enter the name of the account as 
you want it to appear on your financial statements.

•	 Enter additional information about the account as 
needed based on the account type, such as the bank 
account number or a description.

•	 If you need to enter an opening balance for a balance 
sheet account (such as for an existing bank account 
that you didn’t set up during the EasyStep interview), 
click Enter Opening Balance and enter the balance as 
of the QuickBooks Start Date.

5.	 Click OK.
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For a Brand New Account
When you create a brand new account that you didn’t have as 
of the QuickBooks Start Date, leave the opening balance at zero. 
Its opening balance is created automatically when you transfer 
funds from another account.

What type of account should I use?
There are two main types of accounts:

•	 Balance sheet accounts
•	 Income and expense accounts 

Balance Sheet Accounts

Use this 
account To track

Bank Chequing, savings, petty cash, and money 
market accounts. Add one bank account for 
every account your company has at a bank 
or other financial institution. 

Accounts 
Receivable 
(A/R)

Transactions related to the customers 
that owe you money, including invoices, 
payments, deposits of payments, refunds, 
credit memos, and statements. Most 
companies have only one A/R account 
(except when using multiple currencies).

Other 
Current 
Asset

Assets that are likely to be converted to 
cash or used up within one year, such as 
notes receivable due within a year, prepaid 
expenses, and security deposits.
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Fixed 
Asset

Depreciable assets your company owns that 
aren’t likely to be converted into cash within 
a year, such as equipment, furniture or a 
building.

Other 
Asset

Any asset that is neither a current asset 
nor a fixed asset, such as long-term notes 
receivable.

Accounts 
Payable 
(A/P)

Transactions related to money you owe, 
including bills, bill payments, and any credit 
you have with vendors. See also current and 
long-term liability accounts.

Credit 
Card

Credit card purchases, bills, and payments.

Other 
Current 
Liability

Liabilities that are scheduled to be paid within 
one year, such as sales tax, payroll taxes, accrued 
or deferred salaries, and short-term loans.

Long-
Term 
Liability

Liabilities such as loans or mortgages 
scheduled to be paid over periods longer than 
one year.

Equity Owner’s equity, including capital investment, 
owner’s draws, and retained earnings.
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Income and Expense Accounts
Income and expense accounts track the sources of your income 
and the purpose of each expense. When you record transactions 
in a balance sheet account, you usually assign the amount of 
the transaction to one or more income or expense account. 

Use this 
account To track

Income The main source of money coming into 
your company.

Other income Money received for something other 
than normal business operations, such as 
interest income.

Expense Money that is leaving your company.

Other 
expenses

Money spent on something other than 
normal business operations, such as 
corporate taxes.

Cost of 
Goods Sold

The cost of items that you sell.
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Add Customers
You can add, view, and manage customers from the Customer 
Centre. Customers are the people and companies to whom you 
sell your products and services. You can use the information you 
enter to personalize invoices for customers and quickly view the 
status of their accounts. 

Tip: For a video introduction to customers (and other topics), 
visit quickbooks.ca/videos 

To add a customer:
1.	 Open the Customer Centre (go to the Customers menu and 

click Customer Centre, or click Customer Centre on the 
toolbar).

2.	 Click New Customer & Job, then click New Customer. 
3.	 In Customer Name, enter the name of the customer. If 

necessary, also enter an opening balance.
4.	 In the Address Info tab, enter customer information, 

including the full name, billing and shipping addresses, and 
additional contact information.

5.	 Enter details in the Additional Info and Payment Info 
tabs, as desired. 

6.	 Click OK (or Next if you want to enter another customer). 
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Add Vendors
You can add, view, and manage vendors from the Vendor 
Centre. Vendors are the people and companies you buy goods 
and services from to run your business. This could include the 
phone company, office supplies vendor, or utility companies. 

To add a vendor:
1.	 Open the Vendor Centre (go to the Vendors menu and click 

Vendor Centre, or click Vendor Centre on the toolbar).
2.	 Click New Vendor. 
3.	 In Vendor Name, enter vendor name of the vendor. If you 

owe this vendor money as of the QuickBooks Start Date, 
also enter an opening balance.

4.	 In the Address Info tab, enter the vendor information 
including the full name, addresses, and additional contact 
information.

5.	 Enter details in the Additional Info and Account Prefill 
tabs, as desired. 

6.	 Click OK (or Next if you want to enter another customer). 

Add Items
In QuickBooks, an item is anything that your company buys, 
sells, or resells to run your business. Items are your products, 
services, and things such as shipping and handling charges, 
subtotals and discounts.

Tip: For a video introduction to items (and 
other topics), visit quickbooks.ca/videos
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When you choose an item from the Item list on a sales form, 
QuickBooks fills in a description of the line item and calculates 
its amount for you.

QuickBooks provides several types of items. Some items, such 
as Service or Inventory Part items, help record the services and 
products your business sells. Other items, such as the Subtotal or 
Discount item, are used to perform calculations on the amounts 
in a sale.

To add an item:
1.	 Go to the Lists menu and click Item List (or, on the 

QuickBooks Home page, click Items & Services).
2.	 Click the Item menu button and then click New.
3.	 Click Type, then choose the type of item you want to 

create. (For a list of item types, see next page.)
4.	 In Item Name/Number, enter the item name as it should 

appear on purchase and sales forms.
5.	 In Description, enter a description that should appear on 

sales forms when you use the payment item.
6.	 Use the rest of the window to enter any other details 

appropriate for the item type.
 
Tips for entering details on items you buy 
or sell: If you track sales tax, make sure you 
select an appropriate code in the Tax Code 
and Purch Tax Code fields. 

7.	 Click OK (or Next if you want to enter another item).
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Which Item Type Should I Choose?

Item Type Purpose

Services Use for services you either charge for 
or purchase, like specialized labour, 
consulting hours, or professional fees.

Inventory part Use for goods you purchase, track as 
inventory, or resell.

Inventory 
assembly

Use for goods that you assemble from 
parts you buy.

Non-inventory 
part

Use for goods you buy but don’t track, 
like office supplies, or materials you buy 
for a specific job that you charge back to 
your customer.

Other charge Use for miscellaneous labour, material, 
or part charges, such as delivery charges, 
setup fees, or service charges.

Subtotal Use to total all items above it on a form, 
up to the previous subtotal. Useful 
when applying a percentage discount or 
surcharge to many items.
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Group Use to quickly enter a group of 
individual items on an invoice.

Discount Use to subtract a percentage or fixed 
amount from a total or subtotal. Do not 
use this item type for an early payment 
discount. Instead, use Discount & 
Credits from the Receive Payments 
window.

Payment Use to record a partial payment you 
received at the time of the sale. It 
reduces the amount owed on an invoice. 
 

Setting up items in different units of measure
In QuickBooks Premier editions, such as Contractor Edition, you 
can stock items in your inventory in one unit of measure and sell 
them in another. For example, buying soft drinks in a case that 
holds 12 cans, then selling the cans individually.

For more information on setting up items, visit  
quickbooks.ca/getstarted
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Upgrade QuickBooks
Upgrading from QuickBooks 2008 or later?
1.	 Install QuickBooks 2011
2.	 Open your old company file
3.	 You’re ready to go!
If you’re upgrading from QuickBooks Multicurrency edition 
or QuickBooks 2007 or earlier, this version of QuickBooks 
contains many new features and changes. The Upgrader’s Guide 
section contains important information to get you working with 
your company file as quickly as possible.

Tip: For a video introduction on what  
to expect when upgrading, visit  
quickbooks.ca/videos.

 

What company files can be upgraded to  
QuickBooks 2011?
You can upgrade company files from all earlier versions of 
QuickBooks, except for: QuickBooks Enterprise Solutions. 

If you’re upgrading from version 2003 or earlier, you cannot 
upgrade directly to QuickBooks 2011. Instead you must upgrade 
in two steps. Go to our support site at quickbooks.ca/support 
and search “2003” for more details. 
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What should I do with my old version of 
QuickBooks?
If you have QuickBooks Multicurrency edition, QuickBooks 
2007 or earlier, please do NOT uninstall your old version 
of QuickBooks, or more importantly, do not delete your old 
company file. You need it to create sales tax reports or to review 
transactions that took place before you upgraded your company 
file, as well as for audit or tax inspection purposes. During the 
upgrade process, QuickBooks knows the location of your old 
company file and prevents you from overwriting it. 

Before you upgrade your company file
Find your last sales tax return(s): Locate the paper copies of 
the last GST/HST/QST and PST sales tax returns that you filed 
and have them with you when you start the upgrade process. 
You will need information from these returns to upgrade your 
company data.

Your payment details: Locate the payment or refund 
information for your last sales tax payment including how much 
was paid or received and the date for which it was paid. You 
might need to find this information from a GST slip or a cheque 
receipt.

Make a backup of your old company file(s): QuickBooks 
prevents you from overwriting your original company file during 
the upgrade process. However, for added safety, make a backup 
before you start. Set the backup process to perform a complete 
verification.



QuickBooks Getting Started Guide  | 22

Starting the upgrade process
1.	 In QuickBooks 2011, open your old company file.
2.	 Verify you want to upgrade your file by clicking to select the 

checkbox, and then click Update Now.
3.	 Start going through the Upgrade Wizard.
The Upgrade Wizard takes you through the steps necessary to 
upgrade your company file.

To save time, before starting the upgrade process, the wizard 
asks for key information about your data file. We describe the 
most important questions in the sections below.

Tip: At any time in the Upgrade Wizard, click 
the blue links if you want more information.

Home currency
As you go through the Upgrade Wizard, you’ll be asked if you 
use foreign currencies (the Multicurrency feature). If you do use 
foreign currencies, you’ll also be asked to confirm your home 
currency. Make sure you choose the currency that corresponds to 
the home currency in your old company file. 

Why isn’t my home currency brought forward from 
the previous version?  
The Multicurrency feature in previous versions allowed you to 
customize the name of the currency. QuickBooks needs to know 
which currency corresponds to your old home currency so it can 
download the correct exchange rates from the Internet.
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Date of the last Sales Tax period
If you file sales tax (GST, HST, QST, or PST), you will be asked for 
the end dates of the periods for the last GST/HST/QST and 
PST sales tax returns that you sent to the government.

Important: It is vital that you enter the correct 
dates. Otherwise, the sales tax totals in your 
upgraded file will be incorrect!

 

Why do I need this information?
During the upgrade, QuickBooks reassesses your sales tax to the 
end date of your last return, to catch possible sales tax entry 
errors that might be present in your old company file.

We do this now because QuickBooks has a completely new sales 
tax system. The new sales tax system ensures that common user 
mistakes do not affect the accuracy of sales tax reports.   
For example,

•	 Transactions that were entered or modified after sales tax 
was filed

•	 Transactions that contained sales tax, but didn’t have a 
sales tax code associated with them 

Important: If QuickBooks finds sales tax entry 
errors in your old company file, you might have a 
sales tax overpayment or underpayment. When 
the upgrade completes, resolve the overpayment 
or underpayment by downloading a new tool 
from the Upgrade Centre.
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Business forms and reports in the new version
Near the end of the Upgrade Wizard, QuickBooks asks you to 
manually recreate your business forms and reports in the new 
version.

You don’t have to do this right now. After the upgrade is finished, 
the Upgrade Centre lists the items you need to recreate and 
gives you the tools to do so. 

Why do I have to recreate my business forms?
The way that sales tax is reported on business forms (like bills 
and invoices) is different in the new sales tax system. Sales tax is 
now reported only as a total on each form, instead of separate 
amounts for each line, resulting in a more accurate sales tax 
calculation. However, this change prevents us from upgrading 
your customized forms.

Tip: We’ve improved the Layout Designer 
(sometimes referred to as the Customization 
Feature) so it’s even easier to recreate your 
business forms, and we have hundreds of 
templates you can download from the web. For 
more details, see quickbooks.ca/templates
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Finishing the upgrade
When QuickBooks has enough information, it begins updating 
your company file. QuickBooks estimates how much time it will 
take based on the size of your file and displays a countdown 
timer.

After you upgrade your company file, QuickBooks displays the 
Upgrade Centre. From here, you can complete the remaining 
tasks necessary to finish upgrading your company file. Some are 
more critical than others to complete, such as Adjust for sales 
tax overpayment or underpayment. You can complete them at 
your convenience, just click Add Reminder.

Should you require additional upgrading support, take 
advantage of your one free technical support call. Call 1-877-
772-9158 (weekdays 8:00 a.m. to 8:00 p.m. EST). A QuickBooks 
expert will be happy to assist you. 

Also visit our support site for extensive self help information that 
is available 24 hours a day. quickbooks.ca/support
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QuickBooks Payroll
Paying employees is a big responsibility. You have to keep track 
of hours, salaries and wages, social insurance numbers, dates 
of birth, current tax rates and forms, vacation pay and sick 
time, and bonuses, as well as your liability payments to the 
government and benefit agencies.

The following section is only a brief introduction to QuickBooks 
Payroll setup. For more details (including a checklist of 
information you need about your employees), see the following 
resources:

•	 Access the Help Menu in QuickBooks for step-by-step 
instructions for completing Payroll tasks.

•	 Visit quickbooks.ca/getstarted
•	 For a video introduction to payroll (and other topics), visit 

www.quickbooks.ca/videos 

What is QuickBooks Payroll Service?
With a subscription to QuickBooks Payroll, you have access to 
several features and services to help you process your payroll 
quickly and easily. 

As a QuickBooks Payroll subscriber, you never have to stress 
about getting updated payroll tax information from the CRA or 
MRQ again. You will automatically receive updated payroll tax 
tables whenever the Federal or Provincial governments change 
the tax laws. 

How do I subscribe to QuickBooks Payroll?
Subscribing to QuickBooks Payroll is easy. Go to the Employees 
menu, click Payroll, and choose About Payroll Service or call 
us at 1-888-829-8589.
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Payroll Setup
When setting up payroll for the first time,  
you must:
•	 Set up Payroll Items that can be added to an employee’s 

pay cheque.
•	 Set up employees in the Employee Centre.
•	 Set up YTD (Year To Date) amounts for your employees. 

These are totals paid so far this calendar year to each 
employee before starting QuickBooks Payroll, including 
benefits and taxes withheld.

•	 (Optional) Configure Payroll Schedules to save time 
generating pay cheques in the future.

Adding Payroll Items
Add payroll items to pay cheques the same way you add items 
to invoices. Payroll items track amounts such as wages you pay 
and taxes you deduct from pay cheques. There are payroll items 
for compensation, taxes, other additions and deductions, and 
employer-paid expenses. 

By default, QuickBooks creates common payroll items for you. 
However, you may need to add other payroll items for your own 
company, such as additional health benefits that your company 
provides. You’ll need payroll items for hourly wages, salaries, 
commission, and bonuses; government taxes and deductions; 
employee deductions of any kind (such as RSP contributions); 
additions (such as an automobile allowance); and company-paid 
expenses (such as company-paid health insurance).

To create a payroll item:
1.	 Open the Payroll Centre (go to the Employees menu and 

click Payroll Centre).
2.	 In the Payroll Centre workflow window, click Payroll Items.
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3.	 In the Payroll Item List, click the Payroll Item menu button 
and then click New. 

4.	 Choose the type of payroll item you want to create:
 

Use this  
payroll item To track

Wage Money you pay to employees for salaries, 
hourly wages, and overtime.

Addition Money you pay to an employee that is not 
a direct result of their work, such as a car 
allowance.

Deduction Money you deduct from your employee 
other than taxes, such as union dues or 
employee purchases.

Company 
Contribution

Company-paid benefits for your employees, 
such as pension plans or dental benefits.

Other Tax Miscellaneous taxes (company or 
employee paid) based on an employee’s 
wages such as Provincial Health Tax.

Bonus To track “Bonuses”

Commission To track “Commissions”

5.	 Click Next and answer the questions on each screen.

Setting up Employees
To process pay cheques and prepare tax documents for 
your employees, you must enter several details about your 
employees.  
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To add an employee:
1.	 Open the Employee Centre (go to the Employees menu and 

click Employee Centre).
2.	 Click New Employee. The New/Edit Employee window 

opens.
3.	 Enter information about the employee as listed below. 

 

To set up an employee’s personal information:
1.	 In the New/Edit Employee window, go to the Change tabs 

list and select Personal Info.
2.	 In the Personal tab, enter the employee’s personal details, 

including their name, Social Insurance Number (SIN), and 
date of birth.

3.	 In the Address and Contact tab, enter the employee’s 
address and contact information. 

4.	 In the Additional Info tab, define custom fields to store 
other information you want to track, such as the name of 
the employee’s spouse. 

To set up an employee’s payroll information:
1.	 In the New/Edit Employee window, in the Change tabs list, 

select Payroll and Compensation Info.
2.	 In the Earnings section, set up the employee’s wage 

information:
•	 Under “Item Name”, select a salary or hourly payroll 

item, then under “Hourly/Annual Rate” enter the 
amount you pay annually or hourly.

•	 In Pay Frequency, select how often you pay this 
employee. 
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3.	 If you use QuickBooks to track your employee’s time, and 
you pay employees based on this time, click  Use time 
data to create pay cheques. 

4.	 In the Additions, Deductions, and Company 
Contributions section, set up any employee benefits and 
other deductions (except for taxes) that you take from pay 
cheques.

5.	 Click the Taxes button to enter information from the 
employee’s TD1 forms, and review the Income Tax, Canada 
Pension Plan/Quebec Pension Plan, Employment Insurance 
and other payroll taxes he or she might have to pay.

6.	 Click the Accrual Hours button to set up how much time 
an employee accrues, including how much he or she has 
accrued this year.

7.	 Click the Vacation Pay button to set up how much 
vacation pay the employee has available and how much he 
or she earns.

8.	 Click the Direct Deposit button to set up direct deposit 
information. (Note: This is a third-party service and fees do 
apply). 

Set up Year-to-Date Amounts
In order for QuickBooks to calculate tax and other amounts 
during a payroll run, QuickBooks needs to know the amounts you 
already paid to employees before you started using QuickBooks 
Payroll, for this calendar year to date. 

In order to enter YTD amounts, you’ll need:
•	 The amount each employee earned (including former 

employees paid this year). 
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•	 How much was deducted from each employee’s earnings, 
and for what purpose (income tax, EI, CPP, and so on). You 
must also include how much tax your company paid as a 
result of the employee’s earnings (such as the employer’s 
portion of EI).

•	 Vacation pay accrued by each employee (in total, not just 
this year).

•	 Amounts you have remitted so far this year for payroll 
liabilities. 

To enter YTD amounts:
1.	 Open the Payroll Centre (go to the Employees menu and 

click Payroll Centre).
2.	 In the Payroll Centre workflow window, click Set Up YTD 

Amounts.
3.	 Follow the instructions in the wizard. 

Running Payroll
Before you pay employees the first time, you might want to set 
up payroll schedules. Payroll schedules let you group together 
employees who have the same pay frequency so you can pay 
them on the same day.  You can define how often you pay 
your employee (weekly, biweekly, and so on), the date their 
pay cheque is due, and on which day you run your payroll. 
QuickBooks then calculates your upcoming payroll schedule so 
that you can pay your employees on time.

Tip: For a video introduction to paying 
employees (and other topics), visit 
quickbooks.ca/videos
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To set up a payroll schedule:
1.	 Open the Payroll Centre (go to the Employees menu and 

click Payroll Centre).
2.	 In the Payroll Centre workflow window, click Payroll Schedules.
3.	 In the Payroll Schedule list window, click the Payroll 

Schedule menu button and then click New.
4.	 Enter the requested information in the New Payroll 

Schedule window. Enter dates based on the next time you 
will pay employees. QuickBooks will calculate future payroll 
schedules based on those dates. Click OK when you’re done.

5.	 When you want to pay employees, go to the Payroll Centre 
and click Start Scheduled Payroll. 

To pay employees without using a payroll schedule:
1.	 When it is time to pay employees, open the Payroll Centre 

(go to the Employees menu and click Payroll Centre).
2.	 In the Payroll Centre workflow window, click Unscheduled 

Payroll. 

Now you’re on your way to discovering QuickBooks and 
managing your business with efficiency and ease.    
We look forward to connecting with you at  
quickbooks.ca/getstarted

Thank you,

The QuickBooks Team
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Keyboard Shortcuts 
 
 

Copy cheque transaction in register Ctrl + O
Create new invoice Ctrl + I
Delete cheque, invoice, transaction, or item 
from list 

Ctrl + D

Find transaction Ctrl + F
Go to register or transfer account Ctrl + G
History of A/R or A/P transaction Ctrl + H
Memorize transaction or report Ctrl + M
New invoice, bill, cheque or list item in context Ctrl + N
Open account list Ctrl + A
Open Customer Center (Customers & Jobs list) Ctrl + J
Open Help for active window F1
Open list (for current drop-down menu) Ctrl + L
Open memorized transaction list Ctrl + T
Open split transaction window in register Ctrl + S
Open transaction journal Ctrl + Y
Paste copied transaction in register Ctrl + V
Print Ctrl + P
QuickReport on transaction or list item Ctrl + Q
QuickZoom on report Enter
Show list Ctrl + S
Use list item Ctrl + U
Write new cheque Ctrl + W

PN: 700062


